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1. How to install Contact Form plugin from your
Dashboard

1. Log in to your site as an administrator.

--------
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2. Go to your Dashboard and find the menu on your left.
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4. Find Search field.
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6. You will see a list of plugins.
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Find the necessary plugin in the list. Please read the description carefully to be sure you
select the right plugin. Click “Install Now".
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8. If installation complete successfully an “Activate” button will become available. Click
“Activate”.
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2. How to install Contact Form plugin from GitHub

1. Go to_https://bestwebsoft.com/products/contact-form/download and click “Download from

GitHub”

@ BESTWEBSOFT PRODUCTS SUPPORT SERVICES PORTFOLIO

Plugins

Contact Form

CONTACT FORM

httpu//bestwebsoft.com/
httpi//support.bastwebsoft.com/

producad by BESTWEBSOFT

ts  Changelog ~Download

Help & Support

In case you have any questions, or if there Is an issue you want to discuss, please visit our

Support Forum.

863 comments

Ashly, May 4 2012
Great plugin. Thank you
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30+ premium Wordpress plugins can be
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subdomains.
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Free
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2. You will be redirected to the page with the latest plugin version. Click “Clone or
download” => “Download ZIP".

O Personal Open source Business Explore Pricing Blog Support  This repositery Signin m
bestwebsoft / contact-form-wordpress-plugin ©Watch 1 HStar 1 YFork 1
¢»yCode  [Pullrequests 8 4 Pulse Graphs
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I images w
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i languages v4.0.1 amonth ago
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) screenshot-12.png v4.0.1 amonth ago
[® screenshot-13.png v4.0.1 amonth ago
) screenshot-14.png v4.0.1 amonth ago
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) screenshot-2.png v4.0.0 2months ago
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B screenshot-4.png v4.0.1 amonth ago
creenshot-5.png v4.0.1 amonth ago
screenshot-6.png v4.0.1 amonth ago

3. A pop-up window will suggest the place to save. Select Desktop and click “Save”.
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Cancel
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&) screenshot-3.png v4.0.0 2months ago
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4 .Make sure that zip-file has appeared on your desktop.

—

contact=form:
wordpress-plugin-
master.zip

5. Extract the plugin folder to your desktop.

—

contactForm:
wordpress-plugin-
master.zip

L

contact-form:
wordpress-plugin-
master
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6. Read through "readme" file thoroughly to ensure you follow the installation instructions.

onta
ordpre: -
e contact-form-wordpress-plugin-master
frHome Desktop contact-form-wo...s-plugin-master

Places - -
© Recent a

images

A Home
[ Desktop =

Sona
D Documents b=
contact_form.php readme.txt README.md

e ¢ |

¥ Downloads

dd Music r'—l
1@ Pictures -

H videos .pig

@ Trash

screenshots.png  screenshot-6.png Thumbs.db

If you create your own language pack or update the existing one, you can send <a href="http://codex.wordpress.arg/Translating WordPress" target="_blank">the text in PO and MO files</a> for <a href="http://support.bestwebsoft.con"
target="_blank">BestWebSoft</a> and we'll add it to the plugin. You can download the latest version of the program far work with PO and MO files <a href="http://www.poedit.net/download.php" target="_blank">Poedit</a>.

= Technical support =
Dear users, our plugins are available for free download. If you have any questions or recommendations regarding the functienality of our plugins (existing options, mew options, current issues), please feel free to contact us. Please

note that we accept requests in English only. ALl messages in another languages won't be accepted.

If you notice any bugs in the plugins, you can notify us about it and we'll investigate and fix the issue then. Your request should contain URL of the website, issues description and WordPress admin panel credentials.
Moreover we can customize the plugin according to your requirements. It's a paid service (as a rule it costs $40, but the price can vary depending on the amount of the necessary changes and their complexity). Please note that we could

also include this or that feature (developed for you) in the next release and share with the other users then.
e can fix some things for free for the users who provide translation of our plugin into their native language (this should be a new translation of a certain plugin, you can check available translations on the official plugin page).

== Installation ==

1. Upload the “Contact Form' folder to the ' /wp-content/plugins/’ directory

2. Activate the plugin using the 'Plugins' menu in your WordPress admin panel.

3. You can adjust the necessary settings using your WordPress admin panel in "BWS Plugins® > "Contact Form".

4. Create a page or a post and insert the shortcode [bestwebsoft contact form] into the text.

<a href="https://docs.google. com/document,/d/10bcWMPDPIINUXCCLYDWKSWNOFSHVGHYg_VKibipOWTA/edit?pli=1" target="_blank">View a POF version of Step-by-step Instruction on Contact Form Installation</as.

hittp://ww. youtube. com/watch?v=FgAHBXDXtgA

== Frequently Asked Questions ==

= Where can I find the settings to adjust the plugin work after activation?

In the *Plugin’ menu you can find a link to the settings page.

The address specified during WordPress installation will be used by the Contact Form plugin as the default one.

After the plugin installation I haven't adjusted the settings. What is the default email address used for a contact via the form?

= How can I add Contact Form to my website? =
You should put the shortcode [bestwebsoft_contact_form] into your page or post.

= I chose a user via the plugin settings and got this error: "Please enter a valid email address. Settings are not saved.” =

This means that you made a syntax error.

= How to use some other language files with the Contact Form? =

Here is an example for the German language files.
1. In order to use another language for WordPress it is necessary to switch the WP version to the required language and in the configuration wp file -
‘de DE'); . If everything is done properly admin panel will be in German.

wp-config.php’ in the line “define('WPLANG', '*);" write "define('WPLANG',

2. Make sure that there are the files "de DE.po’ and "de DE.mo’ in the plugin (in the languages folder which is in the root of the plugin).

3. If there are no such files you should copy the other files from this folder (for example, for Russian or Italian language) and rename them (you should write ‘de DE' instead of "ru_RU® in both files).
line in English write

4. The files can be edited with the help of the program Poedit - http://www.poedit.net/download.php - please download this program, install it, open the file with this program (required language file) and for eac
translation in German
5. If everything is done properly all lines will be in German in the admin panel and in the front-end.

= How to add the contact form not in English? =
1. Add a language in the block "Lanquage settings for the field names in the form” on the plugin settings page
“Change the nanes of the contact form fields and error messages”, choose the necessary tab,click the twistie to expand the list of the fields and fill in the fields. Choose

2. Mark the check box (if it's not marked yet) in the block
the necessary tab in the block "Action after email is sent™ as well and fill in the field. Save the changes.
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7. With your FTP program upload Contact Form folder to /wp-content/plugins/ folder in
your Wordpress directory online.

NB: In case the name of your extracted folder differs from the name specified in the readme file (i.e.
‘Contact Form’), please change its name to that in the readme file.

ugins
om ent plugi
Places
© Recent i
¥ Home Contact Form

[ Desktop
D pocument its

& Downloads
dd Music

B Pictures
Hvideos

@ Trash
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8. Find the plugin’s menu on your left and click “Installed Plugins”. You will see a list of
installed plugins.

@ & Promo bestwebsoftcom B + New Howdy, admin [l

@ Dashboard
A Posts
) Media
W Pages
¥ Comments.
# Appearance
K Plugins

installed Plugins

Pl ug iNS | Add New

Al (

9. Fi

nd “Contact Form” and click “Activate”.

@ @& promo bestwebsoftcom B + nNew Howdy, admin [l

@ Dashboard
A Posts
07 Media
W Pages
¥ Comments
M Appearance
K Plugins

Installed Plugins

Pl ug iNS | Add New

Al {

bestwebsoft.com 13 of 34
support.bestwebsoft.com


https://bestwebsoft.com/
http://bestwebsoft.com/
https://support.bestwebsoft.com/
http://support.bestwebsoft.com/

Contact Form

10. Voila - Contact Form is activated!

@ & Promo bestwebsoftcom B + New

Howdy, admin [l

@ Dashboard Plugins | addnew

£2 6D

) Media

(LN

1item

Contact Form by BestWebSoft

K Plugins

# Appearance |
Settings Deactivate | Ed

installed Plugins

Plugin
Edito Bulk Actions v | Apply
& Users
& Tools

B Settings

9 BWS Panel

© Collapse me
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3. How to install Contact Form plugin from
wordpress.org

1. Go to http://wordpress.org/plugins/contact-form-plugin/ and click “Download version
4.0.2"” (always the latest one is available).

Q

ORDPRESS.ORG

Mobile Support Getinvolved About Blog Hosting Download WordPress

support.bestwebsoft.com

Contact Form by BestWebSoft
Simple contact form plugin auy WordPress website must have.

Search Plugins

CONTACT FORM
Author
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2. A pop-up window will suggest the place to save. Select Desktop and click “Save”.

WORDPRESS.ORG

Download WordPress

Plugin Directory Username Password Login ] forgor? or Ragiser

Feature
Popular

i
O o me: ontactForm-plugin..0.80) ]
getaTes

saveinfolder: 4 | i@ixxx | EDesktop Create Folder
Developl A ) )
search Pl Places Name

Q search

@ Rrecently Used

3
o B Desktop

e L Flle system

widget(3 [ Floppy Disk
Post (3.6
plugin (3]

admin(d|
posts (24
shortcod)
sidebar
google
wier (3
page (2§

images Ziparchive : |

commal 3
Cancel - i
image (1} —— @

More» 0
1star B 46
ol RM

: Author

@9 Dbestwebsoft
52 plugins
Donate to this pIugin »

I uppont

3. Make sure that zip-file has appeared on your desktop.
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4. Extract the plugin folder to your desktop.

contactform
plugin.4.0.2.zip

contact-form-plugin

5. Read through "readme" file thoroughly to ensure you follow the installation instructions.

contactform
plugin.4.0.2.zip

contact-form-plugin

Places
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& Home
[ Desktop
[ Documents
3 Downloads languages contact_form.php
dd Music
B Pictures -
H videos screenshot-1.png screenshot-2.png screenshot-3.png screenshot-4.png

@ Trash r—

screensholt-5.png screenshot-6.png screenshot-7.png screenshot-8.png
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L‘ ﬁ”‘
8
g
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If you create your own language pack or update the existing one, you can send <a href="http://codex.wordpress.arg/Translating WordPress" target="_blank">the text in PO and MO files</a> for <a href="http://support.bestwebsoft.con"
blank">BestWebSoft</a> and we'll add it to the plugin. You can download the latest version of the program for work with PO and MO files <a href="http://wiw.poedit.net/download.php" target="_blank">Poedit</a>.

target

= Technical support =
Dear users, our plugins are available for free download. If you have any questions or recommendations regarding the functionality of our plugins [existing options, new options, current issues), please feel free to contact us. Please
note that we accept requests in English only. All messages in another languages won't be accepted.

If you notice any bugs in the plugins, you can notify us about it and we'll investigate and fix the issue then. Your request should contain URL of the website, issues description and WordPress admin panel credentials.

Moresver we can custamize the plugin according to your requirements. It's a paid service (as a rule it costs $48, but the price can vary depending on the amount of the necessary changes and their complexity). Please note that we could

also include this or that feature (developed for you) in the next release and share with the other users then.
we can fix some things for free for the users who provide translation of our plugin into their native language (this should be a new translation of a certain plugin, you can check available translations en the official plugin page).

== Installation ==

1. Upload the “Contact Form' folder to the ' /wp-content/plugins/’ directory

2. Activate the plugin using the 'Plugins' menu in your WordPress admin panel.

3. You can adjust the necessary settings using your WordPress admin panel in "BwS Plugins® > *Contact Form®.

4. Create a page or a post and insert the shortcode [bestwebsoft contact form] into the text.

<a href="https://docs.google. com/document,/d/10bcWMPDPIINUXCCLYDWKSWNOFSHVGHYg_VKibipOWTA/edit?pli=1" target="_blank">View a POF version of Step-by-step Instruction on Contact Form Installation</as.

hittp://ww. youtube. com/watch?v=FgAHBXDXtgA

Frequently Asked Questions ==

= Where can I find the settings to adjust the plugin work after activation? =

In the *Plugin’ menu you can find a link to the settings page.

= After the plugin installation I haven't adjusted the settings. What is the default email address used for a contact via the form?
The address specified during WordPress installation will be used by the Contact Form plugin as the default one.

= How can I add Contact Forn to my website? =

You should put the shortcode [bestwebsoft contact form] into your page or post.

= I chose a user via the plugin settings and got this error: "Please enter a valid email address. Settings are not saved.” =

This means that you made a syntax error.

= How to use some other language files with the Contact Form? =
Here is an example for the German language files.

1. In order to use another language for WardPress it is necessary to switch the WP version to the required language and in the configuration wp file - “wp-config.php’ in the line "define(*WPLANG', *');" write "define('WPLANG',
‘de DE*);". If everything is done properly admin panel will be in German.

2. Make sure that there are the files "de DE.po’ and "de DE.mo’ in the plugin (in the languages folder which is in the root of the plugin).

3. If there are no such files you should copy the other files from this folder (for example, for Russian or Italian language) and remame them (you should write "de DE' instead of "ru RU’ in both files)

4. The files can be edited with the help of the program Poedit - http://www.poedit.net/download.php - please download this program, install it, open the file with this program (required language file) and for each line in English write
translation in German

5. If everything is done properly all lines will be in German in the admin panel and in the front-end.

= How to add the contact form not in English? =

1. Add a language in the block "Language settings for the field names in the form" on the plugin settings page

2. Mark the check box (if it's not marked yet) in the block "Change the names of the contact form fields and error messages”, choose the necessary tab,click the twistie to expand the list of the fields and fill in the fields. Choose
the necessary tab in the block "Action after email is sent™ as well and fill in the field. Save the changes.

6. With your FTP program upload Contact Form folder to /wp-content/plugins/ folder in
your Wordpress directory online.

Places =
© Recent ‘

A Home Contact Form
[ Desktop

D pocuments

¥ Downloads

dd Music

G Pictures

Hvideos

@ Trash
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7. Find the plugin's menu on your left and click “Installed Plugins”. You will see a list of
installed plugins.

@ & Promo bestwebsoftcom B + New Howdy, admin [l

@ Dashboard
A Posts
) Media
W Pages
¥ Comments.
# Appearance
K Plugins

installed Plugins

Pl ug iNS | Add New

Al (

8. Fi

nd “Contact Form” and click “Activate”.

@ @& promo bestwebsoftcom B + nNew Howdy, admin [l

@ Dashboard
A Posts
07 Media
W Pages
¥ Comments
M Appearance
K Plugins

Installed Plugins

Pl ug iNS | Add New

Al {
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9. Voila - Contact Form is activated!

@ & Promo bestwebsoftcom B + New

Howdy, admin [l

@ Dashboard Plugins | addnew

£2 6D

) Media

All(1) | Active (1)

W Pages

1item
¥ Comments

Contact Form by BestWebSoft

M Appearance
K Plugins

Settings | Deactivate | £d

installed Plugins
Plugin

Edit Bulk Actions ~ | Apply
- Users
& Tools

B Settings

9 BWS Panel

© Collapse me

bestwebsoft.com 20 of 34
support.bestwebsoft.com


https://bestwebsoft.com/
http://bestwebsoft.com/
https://support.bestwebsoft.com/
http://support.bestwebsoft.com/

Contact Form
Installation Instruction

4. Alternative way of installation

This way of installation is preferable when you download the plugin folder by using a download
link (mostly in case with Pro versions). In this case you do not have to extract the folder with the plugin to
your desktop, it will be extracted automatically in your dashboard.

1. Make sure there is a plugin’s zip-folder on your desktop.
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2. Click “Plugins" in the menu on the left in your admin area.

fi Promo bestwebsoftcom B8 0 4 New

Howdy, admin [l

, v

(2 iz Dashboard

Home

Updates Dismiss
Welcome to WordPress!
We've assembled some links to get you started

A Posts

8] Media Get Started Next Steps More Actions

M Pages

¥ Comments

B Write your first blog post Manage widgets
Customize Your Site
B Tum
v. change .

a +

M Appearance
K Plugins

& Users Ata Glance v Quick Draft -
# Tools

Activity - WordPress News
B Settings

© Collapse menu

3. Click “Add New" at the top of the page.

@ @& promo bestwebsoftcom B + nNew

Howdy, admin [l

— .
@& Dashboard Plugins

A Posts

97 Media Plugir Description
1M Pages You do not appear to have any plugins available at this time.

¥ Comments. o

escription
M Appearance
K Plugins

Installed Plugins
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4. Click “Upload Plugin”.

# Promo bestwebsoftcom B + New Howdy, admin [l

@ Dashboard Add Plugins
A Posts
Featured  Popular Keyword ~
) Media
@ Pages Pl { and expand the functionality of ordere: upload a plugin in.zip
¥ Comments
BuddyPress + - Jetpack by WordPress.com Inst bbPress

# Appearance

K Plugins
instalk
Add New
Eciton Last Updated (203) Last Updated: 1 month
& Users 243) Last Updated: 2 weeks aga 1+ R Compatible Wit ol version 300,000+ Active Installs Untested with your version of press
200,000+ Active Installs Untested with your version of WordPress
& Tools
B Settings
Theme Check nstall Now nstall N WP Super Cache nstall Now
L
your theme Details Mare Details ast caching engine for WordPrass
rds and . . du tic html files.
t tool
Last Updated: 3 months ago Last Updated: 3 (863 Last Updated: 3 months ag
100,000+ Activ Untested with your version of WordPress 1+ Million Active Installs with your version of WordPress 1+ Million Active Installs Untested w

Popular tags

You

y also browse based on the most popular tags in the Plugin Directory:

admin s
Facebook feed

comments

h form gallery goog\e hitml image Images javascript jquery link links pist login u o
oues PIUGIN pugns POSt POStS cone responsive rss search security seo Share » shortcode s sidebar smpe sider s

tracking fWWIttEr s video Widget widgets woocommerce wordpress

AJAX  analytics api buddypress

dia men:

social social media spam

5. Click “Choose file".

# Promo bestwebsoftcom B + New Howdy, admin [l

@ Dashboard

Add Plugins | upload Plugin

A Posts

97 Media

] If you have a plugin in a zip format, you may install it by uploading it here.
Pages

¥ Comments

M Appearance

K Plugins
installed pi
Add New
Editos
Featured ar orites Keyword v 5 p
& Users
& Tools Plugins extend and expand the s or upload a plugin in zip format by clicking the button at the top of this page.
B Settings
o BuddyPress Install Now + . Jetpack by WordPress.com bbPress nstall Now
BuddyPress helps you build any ¢ . bbPress is forum software, made the
- rdPr
By T o
Last Updated: 2 days age 203 Last Updated: 1 month at
3 1+ Million Act + Compatible <ion of W 300,000+ Active Installs your version of Word
200,000+ Active Installs Untested with your versi
Theme Check Install Now Akismet Install Now WP Super Cache
A simple and easy way t \ments against hing engine for W
for all th NordPre . . 0 see if ti tatic htm|
ractices. A great theme
Last Updated: 3 months ago (863) Last Updated: 3 mor
140) 1+ Million Active Installs Untested wi on of WordPress = Million Active Installs iith your version
00,000+ Active Installs
Popular tags
You may also browse based on the most popular tags in the Plugin Directory v
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6. A pop-up window will ask you to choose the file. Select contact form zip-folder and click

uo pen".

&

Promo bestwebsoftcom B + New

@ Dashboard Add Plugins  uslosd plugin

# Pages

® comments

If you have a plugin in a .zip format, you may install it by uploading it here.

File Upload

» Appearance
% Plugins # |4 [@xxx | EDesktop
i . Places
Add New Q search

D recently Used
. Featured Popular Recommended  Favorites B XXX
a Users @l Desktop

L File system

& Tools
I8 Floppy Disk

Plugins extend and expand the functionality of WordPress. ¥{
B setting

BuddyPress
o yPr

BuddyPress helps you build any|
community website using Wordf
member profiles, activity stream
groups, messaging, and more.

By The BuddyPress Community:

(243)

200,000+ Active Installs Untested §

Theme Check

Asimple and easy way to testyg
for all the latest WordPress staf
and practices. A great theme
development tool!

AllFiles

Lancel

y,admin [l

Keyword J

page.

bbPress

Install Now

bbPress is Forum software, made the
WordPress way.

Maore Details

(203)

+ Active Installs

By The bbPress Community

Last Updated: 1 monthago

Untested with your version of WordPress

WP Super Cache Install Now

Avery fast caching engine for WardPress
that produces static html files.

More Details

By Automat

————

By Ottod2, pross

(532)

(140) Last Updated: 3 months ago

jon Active Installs

(863) Last Updated: 3 months ago

1+ Million Active Installs

Last Updated: 3 menths ago

Untested with your version of WordPress Untested with your version of WordPress

100,000+ Active Installs

Untested with your version of WordPress

Popular tags

7. Click “Install Now".

# Promo bestwebsoftcom B + New

Howdy, admin [l

@ Dashboard

Add Plugins | upload Plugin
A Posts
B Media
M Pages

“omments

M Appearance
K Plugins
installed pi

Add New
Edito

Featured orites
& Users

& Tools Plugins extend and expand the
B Settings

- BuddyPress

idyPress helps you build any

200,000+ Active Installs Untested wi

Theme Check

Install Now

A simple and easy w

NordPre

for all th

ractices, A great theme

140)

00,000+ Active Installs

Popular tags

You may also browse based on the most popular tags in the Plugin Directory
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If you have a plugin in a zip format, you may install it by uploading it here.

Choose File | contact-form-pluginzip

s or upload a plugin in zip

format by

licking the button at thy

Jetpack by WordPress.com

Last Updated: 2 days age

1+ Million Act + Compatible sion of W
Akismet Install Now
wments against
. . 0 seeif

Last Updated: 3 months ago

Million Active Installs Untested wi

on of WordPress

Keyword

e top of this page

bbPress

bbPress is forum software, made the

rdPr

Last Updated:

month 2

300,000+ Active Installs

your version of Word|

WP Super Cache

hing engine for W

atic html

Last Updated: 3 mor

(263,

+ Million Active Installs

ith your version
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8. The resulting installation screen will list the installation as successful or note any problems
during the install.

@ & Promo bestwebsoftcom B Howdy, admin [l

O =izl Installing Plugin from uploaded file: contact-form-plugin.zip

A Posts

) Media

W Pages

¥ Comments.

2 Appearance
K Plugins
installed Plugins
Add New
Editor

- Users

& Tools

B Settings

9. Click "Activate Plugin”.

@ @ Ppromo bestwebsoftcom B Howdy, admin [l

O btz Installing Plugin from uploaded file: contact-form-plugin.zip

A Posts
7 Media

M Pages

¥ Comments

M Appearance
£ Plugins
installed

Add New
Editor

- Users

& Tools

B Settings
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10. Voila - Contact Form is activated!

@ & Promo bestwebsoftcom B + New

Howdy, admin [l

@ Dashboard Plugins | addnew

£2 6D

) Media

(LN

1item

Contact Form by BestWebSoft

K Plugins

# Appearance |
Settings Deactivate | Ed

installed Plugins

Plugin
Edito Bulk Actions v | Apply
& Users
& Tools

B Settings

9 BWS Panel

© Collapse me
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5. How to use the plugin

1. Find the menu on your left.

@ & Promo bestwebsoftcom B + New Howdy, admin [l
() i Dashboard
Home
Updates
Welcome to WordPress!
We've assembled some links to get you started
A Posts
o fia Get Started Mext Steps More Actions
W Pag K Write your first blog post
Customize Your Site
¥ Comments + Ad
or, change your theme completel = v i
M Appearance
% Plugins
& - Ata Glance v Quick Draft -
Vs
Activity v ‘WordPress News
B Settings

3 BWS Panel

O coll

2. Select “BWS Panel” =>"Contact Form".
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@ & promo bestw

@ Dashboard

Posts.
Media
Pages

Comments

Appearance

Plugins
jsers

Tools

Settings

fi Promo bestwebsoftcom B8 0 4 New

Dashboard

Activity

Welcome to WordPress!
We've ass ed some links t ) started:
Get Started
At a Glance v

Howdy, admir

Mext Steps More Actions

Manage wi

Quick Draft -

WordPress News v

3. You will see Contact Form Settings page.

@ Dashboard

A Posts
) Media
W Pages

¥ Comments

# Appearance
¢ Plugins
Users

.
-
# Tools

Contact Form Settings

Settings  Additional settings ~ Appearance  Custom code low to Use Step-b

NEW_FORM

would like tc

f you leave the fields empty, the messag:

t to the email a

The user’s email address: | sa

Use this email address: 0

Add department selectbox to
the contact form:

Technical department

Economical department

Add

* If you upgrade to Pro version all your settings will be saved.

Unlock pramium options by upgrading to Pro version

Save emails to the database

Save Changes

Restore all plugin sef

settings

Hyou enjoy our plugn, please give it 5 stars on WordPress: Rate th

ntact us: hitp://supp

If there is something wrang about it please

Danations play an important role in supporting great projects:

bestwebsoft.com

Howdy, admin [l

ruction

ntact Form to your page or post, please use [ button @

i during registration.

1 technical@example.com

1 economical@example.com

1
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4. Configure the plugin the way you like.

# Promo bestw Howdy, admin [l
LC—Ed] Contact Form Settings
A Posts Settings  Additional settings ~ Appearance  Custom code =
O Media
NEW_FORM
B Pages

uld like to

ntact Form to your page or post, please use [ button @

¥ Comments

e fields empty, the messag i during registration.
A Appearance
& Plugins The user’s email address: | Selact s usemame of the pes et the me:
& Users
F Tools Use this email address: .
B Settings
Add depariment selectbox to
@ BWS Panel the contact form: 7 ~ 7 5
Technical department 1 technical@example.com
Plugins
Economical department 1 economical@example.com
hemes 1
tus Feed
Contact Form
© coll - * If you upgrade to Pro version all your settings will be saved.
Unlock premium options by upgrading to Pre version
| Save emails to the database sing Contact Form to DS by BestWebSoft) Downioad Co i

Save Changes

Restore all plugin set

settings

If there is something wrong about it. please

Danations play an important role in supporting great projects:

5. Select Additional Settings tab at the top of Contact Form Settings page and customize the
plugin the way you like.

@ & Promobestwebsoftcom B 0 + New Howdy, admin [l

@ Dashboard Contact Form Settings

07 Media

NEW_FORM
W Pages

would like tc

. ? fyou ntact Form to your page or post, please use [ butten @
“omments

A Appearance Sending method . -
% Plugins Mail s the oF
& Users
& Tools "FROM" field Name Emai

®) Promo bestwebsoft.cc ®) wordpress@bestwebsaf
B Settin

User name @ User email @
@ BWS Panel e T S
Plugins
Required symbol .
Them
tus
Fields Used Required  Visible Disabled for editing Field's default value
(i Gepartment
O co Name v v Use Users name o< o defauit valie i the user i< loaged in.
cation selectbox Field's defautt value:
Choose File

] {se Usei’s eimail as & defaull valle f the User s i

v Field's defaglt value:

] Fisld's defaglt vaite

Unlock premium options by upgrading to Pro v

Add to the form Tips below the Attachmes

d me a copy’ block @

Subsc

er by BestWebSoft pounis
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6. Select Appearance tab at the top of the Contact Form Settings page and customize the

plugin the way you like.

# Promo bestwebsoftcom § 4+ New

@ Dashboard Contact Form Settings

9 Media
NEW_FORM +
M Pages
[y — Form layout ©) One column
Two columns
2 Appearance
[ s Submit position o Left
& Users Right
# Tools
Settings Form align Left
Center
@ BWS Panel
Right
Plu
iz Labels position Top
System Status
Left
Contact Form Right
o Bottom
Labels align Left
Center
Right
Errors output
Add placeholder to the input
blocks
Add tooltips Name
Email address
Subject
Message
Attachment
Captcha by BestWebSoft
Style options.

Howdy, admin [l

How to Use Step-by-step Instruction

Contact Form | Preview

Name:
Email Address:
Subject:

Message:

If you would like to add the Contact Form to your
website, just copy and paste this shortcode to your post
or page or widget

[bestwebsoft_contact_form]

7. The changes you make immediately display on your right in the preview window.

@ Dashboard Contact Form Settings

A Posts Settings  Additional settings  Appearance  Custom code
07 Media

NEW_FORM
W Pages

Form layout Ore column

Two columns
M Appearance

£ Plugins Submit position o Left
o Users Right
& Tools
B Settings Form align Left
Center
3 BWS Panel
Right
P
Labels position Top
B Left
Contact Form Right
O co Bottom
Labels align Left

Errors output

Add placeholder to the input
blocks

Add tooltips

y BestWebSoft

Style options

bestwebsoft.com

support.bestwebsoft.com

Howdy, admin [l

Contact Form | Preview

Name:

Email Address:
Subject

Message:

Submit

bestwebsoft_contact_form]
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8. Don't forget to save the changes before switching the tabs.

# Promo bestw Howdy, admin [l
LC—Ed] Contact Form Settings
A Posts Settings  Additional settings ~ Appearance  Custom code =
O Media
Settings saved.
B Pages
¥ Comments NEW_FORM +

A Appearance use [ b [}

¢ Plugins specified during registratios
& Users
1 The user's email address: | sel
B Settings
Use this email address: . e e
¥ BWS Panel
plugins Add department selectbox to
- the contact form:
Technical department technical@example.com
tus : 1 4 G
Economical department 1 economical@example.com
Contact Form 1
Add
©Q coll

* If you upgrade to Pro version all your settings will be saved.

Unlock premium options by upgras

Save emails to the database

all plugin settings to defaults

gs

If you enjoy our plugin, please give it 5 stars on WordPress: Rate.

Ifthere is something wrong about it please contact us: http://supportbestwebsoft.com

Donations play an important role in sUDDORting areat projects: Don.

9. Widget settings for using the shortcode in the sidebar.

o —- I Howdy, admin [
@ Dashboard Widgets | Manage with Live Prey
A Posts o N
Available Widgets Sidebar * Content Bottom 2 M
1 Media To activate  vidget drag it to a i ck on it To deactivate g it back Add widgets here to appear in your

W Pages
Archives Calendar Saarch v
¥ Comments

A monthly archive of your s A calendar of your ste's Posts.
# Appearance Recent Posts v
Categories Custom Menu
Recent Comments v
Widgets
Meta Pages Archives v
Aen
Header Login, R o
. Categories v
Recent Comments Recent Posts
Edite
Pages v
& Plugins o
& Users RsS search Text: Contact Form =
# Tools Entries from any RSS or Af A search form wr site.
B Settings Contact Form
Tag Cloud Text
3 BWS Panel .

antact_form]

[-]

Inactive Widgets

45 he

Automatically 3dd paragraphs
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10. Add a Contact Form via shortcode to a page or a post.

bestwebsoft.com i + New

Dashboard
A Posts
9] Media
W Pages

All Pages

Cammen

Appearance

Y

Plugins

* B

B Settings

) BWS Panel

Edit Page Add new

Sample Page

Permalink:

Q7 Add Media

B I »== = = ¢ —

Paragraph v U

A

This is an example page. It's different from a blog post because it will stay in one place and will show up
in your site navigation (in most themes). Most people start with an About page that introduces them to

potential site visitors. It might say something like this:

Hi there! I'm a bike messenger by day, aspiring actor by night, and this is my blog. I live in
Los Angeles, have a great dog named Jack, and I like pina coladas. (And gettin' caught in the
rain.)

_or something like this:
The XYZ Doohickey Company was founded in 1971, and has been providing quality

doohickeys to the public ever since. Located in Gotham City, XYZ employs over 2,000 people
and does all kinds of awesome things for the Gotham community.

As a new WordPress user, you should go to your dashboard to delete this page and create new pages for

your content. Have fun!

[prmbr_shortcode]

Wordpress

Add BWS Plugins Shortcode

SHORTCODE SETTINGS

~| Language

[bestwebsoft_contact_form]

Official website;_bestwebsoft.com

Help & Support: support.bestwebsoft.com

visual  Text

n on April 15, 2015 8t 935 am

Publish -
Preview Changes

9 Status: Published Ecit

® Visibility: Public Edit

D Revi

i Publish

on: Dec 4, 2014 @ 08:40

Page Attributes a
Parent
(ne parent) ~

Order

0

help? Use the Help tab above the
title.

Featured Image N

Set featured image
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11. To find out more about Contact Form by BestWebSoft plugin customization review How
to Use Step-by-step Instruction

@ & promobestwebsoftcom B8 0 4 New
& Dashboard Contact Form Settings
# Posts Settings  Additional settings  Appearance  Custom code How 10 Use Step-by-step nstruction
O3 Media
NEW_FORM
M Page:

iease use [ button @

fiyou would like to add a Contact Form 10 y¢

¥ Comment:
i you leave the fields empty, the messages will be sent to the email address specified during registration.

M Appearanci

¢ Plugins The user's email address: | Select s usemame of the pe

& Users

& Tools Use this email address:

B Settings

Add department sefectbox to

@ BWS Panel the contact form: o Z Z % Z
Technical 3 technic com

Plugins
Economical department 3 economical@example.com

1

Add

Contact Form

O col * If you upgrade to Pro version all your settings will be saved.

Save emails to the database

Restore all plugin settings to defaults

e settings

Ifyou enjoy our plugin, please give it 5 stars on WordPress: Rate the plugin
If there is something wrong about it, please contact us: hittp://support bestwebsoft.com

Danations play an important role in supporting great projects: Donate

This instruction can be applied mostly to Contact Form Pro, too.

Help & Support

Visit our Help Center if you have any questions.

Our friendly Support Team is happy to help.
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Contact Form
Installation Instruction

support.bestwebsoft.com

Need Website Development or Design Services?

We provide additional services such as Wordpress themes & plugins development, graphic design,
custom programming.

Contact us now to get a free quote — https://bestwebsoft.com/contacts/
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	Visit our Help Center if you have any questions. 
	Our friendly Support Team is happy to help. 


